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STATEMENT 
“To provide a venue, 
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message in the most cost-

effective manner.” 
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Facility Operations 
 
SWOCC STUDIO PROCEDURES 
 
1. Office hours are 8:30 a.m. – 4:30pm. Monday thru Friday.  Evenings and weekends 

are by appointment. 
 
2. All questions, troubleshooting, scheduling, and checkout of equipment must go 

through Community Relations, or staff person assigned to production. 
 
3. First-time shows require character generation to be prepared at least one day in 

advance by a crew person. On going productions (those with CG already formatted) 
may take changes at the time of the show.  

 
4. Access on those areas necessary for production. Staff offices (including front office) 

are off limits.  
 
5. Staff will supervise all shoots and complete all technical adjustments. Staff will NOT 

crew any positions for any show at any time. Staff reserves the right to stop, or cancel 
any production for any reason at anytime. 

 
6. Residents may not touch (use) equipment without staff approval.  
 
7. Do not step on or roll over any cables.  
 
8. The facility is to be left exactly as it was found.  
 
9. Crew is responsible for returning/putting away the equipment they used/manned.  
 
10. The producer is responsible for tape stock, actions & behaviors of guests, talent & 

crew. Also producer is responsible for cleaning up after their production. 
 
11. In the event any procedures are violated, staff will complete necessary documentation 

to alert the Executive Director who will determine action, up to and including 
suspension of facility privileges.  

 
12. Policies for use of studio, equipment and access channels are set forth in the SWOCC 

Public Access Television Policies.  
 
13.  All procedures are noted in the Producers workshop. 
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Facility Operations 
 
Procedures For Production 
 

1. Producer must contact the SWOCC to set up a pre-production meeting with a 
SWOCC staff member, at least two weeks prior to the studio production. 

 
2. During the Pre-Production meeting, perimeters of the production will be set. 

Anything not discussed previously in the pre-production meeting will not be 
allowed or implemented during the actual production. 

 
3. A pre-production meeting must take place prior to each production/show until 

staff deems unnecessary. Staff reserves the right to require pre-production 
meetings as necessary.  

 
4. Producers must arrive within 15 (fifteen) minutes of the scheduled appointment 

time. A user arriving more than fifteen minutes late will have their reservation 
forfeited. 

 
5. Producers are responsible for set-up and strike of the set. Appointment times 

should be made to reflect the necessary needed time for each production.  
 

6. Producers are expected to contact SWOCC staff if he/she is unable to make an 
appointment, or if they will be delayed. Leaving a voice message does not 
constitute a reservation cancellation or tardiness. Confirmation must be received 
from a staff member. 

 
7. Producers may only use certified crew for a production. The producer is required 

to provide a complete list of crew and assignments to their assigned staff member 
prior to a production. 

 
8. Producers are responsible for understanding and following all polices in the 

Public Access Polices book. Producers are responsible for their crew, talent and 
other persons on set, and that they must abide by the same polices. 
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WEEK 1           Intro to the Camera 
 
Physical Attributes of the Camera 
 
Lens-What the Camera Sees 
 Zoom-Change what the camera sees from wide angle to narrow angle. 
 Focus- Used to make the picture appear sharp and clear  
 Iris- Controls the amount of light that enters the lens.  
  
CCD (Charged-Coupled Device)- a small solid-state silicon chip that 
contains horizontal and vertical rows of thousands of light sensing picture 
elements called pixels.  
 
View Finder- a small video monitor attached to the camera that displays the 
picture the camera generates.  
 
Tally Light- A red light on the camera and in the view finder that lights up 
when the camera is “hot,” or live.  
 
Filter Wheel- Located between the lens and the camera body. Normally 
have three possible settings. For studio lighting the filter should be set on 
filer 1. 
 
 View Finder Tally Light 

Tally Light 

Lens 

Filter Wheel 
6
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WEEK 1           Intro to the Camera 
 
Under the Camera 
 
Tripod (sticks) 

Zoom Control 
Focus Control 
Tilt Control/Lock 
Pan Control/Lock 
Pedestal Control/Lock 
Leg Height Control/Lock 
Camera Head-Mount 

Dolly 
Wheels 
Tripod Feet Lock 

 
 
Movement Definitions 
 
Tilt up/down- Up and down movement of the camera on the tripod. 
Pan right/left- Side to side movement of the camera on the tripod. 
Pedestal up/down- Physically raising or lowering the camera with the tripod. 
Zoom in/out- Either using the Zoom Controls or Manually adjusting the zoom in or 
out until the subject is in frame. 
Dolly in/out- Movement of the camera and tripod across the floor toward the subject 
(dolly in) or away from the subject (dolly out). 
Truck left/right- Side to side movement of the camera and tripod across the floor. 
Tracking- As subject moves, the camera and tripod move across the floor following 
parallel the subject. 
Arching- Camera trucks and dolly’s at the same time, moving in a semi circle around 
the subject. 
Lock Down- Establishing a shot with a camera, and locking the camera into one 
position without any camera or tripod movements. 
 



 8

SWOCC Studios 
Studio A Training Class 

 
 
WEEK 1          Intro to the Camera  
 
The Tripod 
 
 
 

Zoom Control 

Focus Control 

Tilt Control/Lock 

Pan Control/Lock 

Pedestal Control/Lock 

Leg Height 
Control/Lock 

Camera Head-Mount

Wheel Lock 

Servo Arm 

Dolly 
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WEEK 1          Intro to the Camera  
 
Camera Movement Examples 
 

 

Dolly in 

Dolly out 

Truck Left 

Truck Right 

Arc Left 

Arc Right 

Pan Left Pan Right 

Tilt Up 

Tilt Down 
Pedestal Up 

Pedestal Down 
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WEEK 1          Intro to the Camera  
 
Through the View Finder 
 
Aspect Ratio- The ratio of the width of the television screen to its height. 
The standard ration is 4 x 3 ( four units wide by three units high); HDTV 
(high-definition television) is 16 x 9 ( sixteen units wide by nine units high).  
 
White Balancing- To see a white object as white, the camera must be told 
whether the light in which it is operating in is white. This is a camera 
adjustment to compensate for a bluish or reddish light. White balancing the 
camera should be done anytime the light changes on an object. This is an 
automatic feature on most consumer camcorders. 
 
Safe Title- Refers to the picture area that will be seen by most television 
receivers in the home. 
 
Camera Bars- Serves as a reference for the color monitors or for the 
playback of the recording. 
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Framing Definitions 
 
 
XCU (Extreme Close-Up) – A view of just the subjects face. 
 
CU (Close-Up)- A head and shoulders shot of subject. 
 
MS (Medium Shot)- A view of the subject from the waist up. 
 
LS (Long Shot)- A view of the subject from head to toe. 
 
WS (Wide Shot) or XLS (Extreme Long Shot) or Cover Shot- A view of 
the subject and their surroundings. 
 
One Shot - One person in the frame. 
 
Two Shot- Two people in the frame. 
 
Three Shot- Three people in the frame. 
 
Over the Shoulder- A camera view looking over the shoulder of one 
subject at another subject face front. 
 
Headroom- Space above the head of the subject 
 
Talk (Lead) Room- Space in front of a profiled subject, or ahead of 
someone moving on camera. 
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WEEK 1          Intro to the Camera  
 
Picture Composition Examples 
 
 
 
. 

Extreme Long Shot (XLS) 
or Cover Shot 

Long Shot (LS) or 
Full Shot 

Medium Shot (MS) or 
Waist Shot 

Close-up (CU) Extreme Close-up (XCU) 

Two Shot Over the Shoulder Shot 
(O/S) 
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WEEK 1          Intro to the Camera  
 
Picture Composition Examples 
 
 

Too Much Headroom Too Little Headroom 

Too Little Noseroom Too Much Noseroom Perfect Noseroom 
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WEEK 1          Intro to the Camera  
 
Picture Composition Examples 
 
 

Pointing to Nose Room 

Problematic Composition: 
Plant 

Problematic Composition: 
Flag 

Too Little Leadroom Perfect Leadroom 
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WEEK 1           Intro to the Camera  
 
Before the Show 
 

 Put on your headset and check whether the intercom system is functioning. You 
should hear at least the director, technical director (TD), or another camera operator. 

 
 Unlock the pan-and-tilt mechanism on the camera-mounting head and adjust the drag, 
if necessary.  

 
 Adjust the tripod so that the camera frames the subject appropriately or per the 
director.  

 
 Adjust the viewfinder so you can see the picture the camera is taking. 

 
 Check the zoom lens, utilizing the zoom control. Zoom in and out. Get a feel for the 
zoom range, speed and position.  

 
 Rack through the focus, utilizing the focus control. Focus from one extreme to the 
other.  

 
 Calibrate (preset) the zoom lens. Zoom in all the way in on the target object (usually 
on something that gives you enough detail, i.e. Hairline, or eye). Focus in on this 
object. Now Zoom out all the way back to the widest setting. You should now remain 
in focus throughout the zoom. If the camera or object moves, the focus changes- you 
must re-calibrate the zoom. 

 
 Lock the camera (pan-and-tilt mechanism) before leaving it. DO NOT leave a camera 
unlocked, even for a short while.  

 
During the Show 
 

 Put on the headset and establish contact with Director. 
 

 Unlock the camera and recheck pan-and-tilt drag and pedestal movement.  
 

 Calibrate the zoom if camera position has changed or subject has moved. 
 

 If you have to truck or dolly, make sure the floor is clear of cables, etc. 
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 Check the pedestal. Generally keep your shots at the talents eye level unless the 
director instructs you to shoot either from a high or low angle. 

 
 At all times during the show, be aware of all other activities around you. Where are 

the other cameras? Where are any cables? Is your camera “hot”? If not which camera 
is hot? It is your responsibility to keep out of the view of other cameras and not hit 
anything.  Do not make loud noises or large movements that could distract the on 
camera talent. 

 
 Keep your eyes on the viewfinder. 

 
 Watch for the tally light to go out before moving the camera into a new shooting 
position or re-calibrating your zoom. 

 
 Listen carefully to what the director tells all the camera operators, not just you. That 
way you can coordinate your shots with those of the other cameras. You can avoid 
wasteful duplication of shots by knowing approximately what the other cameras are 
doing.  

 
 Avoid unnecessary chatter on the intercom. 

 
 
After the show 
 

 At the end of the show, wait for the “all clear” signal before you lock the camera. 
 

 Lock the camera mounting head, pan-and-tilt mechanism and the pedestal. Push the 
camera to its stored location. 

 
 Coil the cable neatly, and replace it to the designated area. 

 
 Assist with the remaining crew with complete strike of the set.  
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Week 2  
Production Roles and Control Room 
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WEEK 2      
 
Crew Definitions 
 
Producer In Charge of one or several program series. Manages budget and 

coordinates with talent, clients, studio management, writers, etc. 
Incurs sole responsibility for all aspects of a production, including 
all personnel working on a production, coordinating technical, and 
non-technical production elements. Often serves as director and 
writer.  

 
Asst. Producer Assists producer in all production matters. Often do those actual 

coordinating jobs, such as telephoning to schedule and confirm 
crew, talent, studio reservations, etc. 

 
Director In charge of directing talent and technical operations. Is ultimately 

responsible for transforming a script into an effective video and 
audio message. 

 
Technical Director Does the switching and acts as technical crew chief. Often serves 

as director. 
 
Production Asst. Assists producer and director during actual production.  
 
Camera Operator Operates camera, takes direction from Director, one operator often 

serves as floor manager.  
Audio Technician In charge of all audio operations. Works audio console (mixer) 

during the show. Takes cues from director. 
 
C.G. Operator Types and/or recalls from the computer the names and other 

graphic material to be integrated with the video image. Takes cues 
from the director. 

 
Floor Manager In charge of all activities on the studio floor. Directs talent, relays 

director’s cues to talent, and supervises floor personnel. 
 
 
Talent Refers to all performers and actors who regularly appear on 

television. 
 
Editor Non-linear or linear edits the production according to the 

producer’s notes, or direction. Often is done by the producer or 
director. 
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WEEK 2           
 

The Control Room 
 
The Switcher- A panel with rows of buttons that allows the selection and assembly of 
various video sources through a variety of transition devices, and the creation of 
electronic special effects.  
 
VTR (Video Tape Recorder)- Records the Video and Audio signal onto videotape.  
 
The Character Generator- A computer dedicated to the creation of letters and numbers 
in various fonts. Its output can be directly integrated into video images.  
 
CCU ( Camera Control Unit)- Equipment, separate from the actual camera, that allows 
the video operator to adjust the color and brightness balance before and during the 
production.  
 
The Audio Console (Board or Mixer)- Controls the volume of all inputs, mix some or 
all of the inputs signals in various ways, and manipulate the sound signals of each 
channel for the final mix.  
 
CD Player- Compact disk player used to add music to studio productions. 
 
Clear Com- Intercom system used to facilitate voice communication between control 
room, camera operators, and floor manager.  
 
Program Monitor- Program output of the video switcher. 
 
Preview Monitor- Preview output of the video switcher. 
 
QC (Quality Control) Monitor- Used in studio production to check the video of 
routable sources, most commonly the record deck. 
 
Waveform/Vector Scope Monitor- Measures the brightness and color of the program 
video signal. 
 
On-Air Light- Light that is turned on to alert others a production is in progress.  
 
Teleprompter- A prompting device that projects copy over camera 1’s lens so the talent 
can read it without losing eye contact with the viewer.  
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WEEK 2      
 
The Control Room 
 
 
 

 Preview 
Monitor 

Program 
Monitor 

QC  
Monitor 

Waveform/ 
Vector Scope 

Monitor 

The Switcher 

VTR 1 

Audio Board 

CD Player 

Teleprompter 

CCUs 

On-Air Light 

Audio 
Monitors 

Character 
Generator 

Edit 
Controller 

VTR 2 
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WEEK 2      
 
The Switcher 
 

Background Bus (Program) 

Foreground Bus (Preview) 

T-Bar 

Cut Button 

Auto Transition 
Button 

Fade to Black

Down Stream Key 

 
Auto Trans Duration 

Mix Effect 
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WEEK 2      
 
How to set up the Switcher 
 
The Switcher is always on. 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1- Pull or Push the T-Bar all the way toward or away from you. 
2- Press DSK Fill, the button will light. 
3- Press Auxiliary 5, the button will light. 
4- Press Mix, the button will light. 
5- Press Set until “Effect” lights. 
6- Enter number of frames for the Auto Trans to dissolve (30 fra
7- Press Enter. 
8- Press Set until “DSK” lights. 
9- Enter the number of frames for the DSK to dissolve. 
10-  Press Enter 
11- Press Set until “FTB” lights. 
12- Enter the number of frames to Fade to Black. 
13- Press Enter

1 

2 
3 

4 

5, 8, 11 

6, 
9,  
12 
7, 
10, 
13 
22

 

mes = 1 second) 
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WEEK 2      
 
The Switcher 
 
Foreground (Preview) Bus- Lit button is being sent to the Preview Monitor. 
Background (Program) Bus- Lit button is being sent to the Program Monitor. 
 
Cut- The instantaneous change from one shot (image) to another. 
 
Mix Mode- Dissolves are used to transition from one video signal to another. 
 
Effect Mode- Effects are used to transition from one video signal to another. 
(Both Mix and Effect may be done Manually or by Auto-Transition) 
 
Manual- Use T-Bar to manual transitions. 
Auto-Trans- Press button to transition between Preview and Program for a pre-set 
amount of time.  
 
 
DSK (Down Stream Keyer)- A control that allows the title to be keyed (cut-in) over the 
picture (Program out signal) as it leaves the switcher.   
 
Fade to Black (FTB)- Fade all video signals leaving the switcher to black.  
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WEEK 2      
 
Directing using the Switcher 
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To Cut 

1- Select the video source on the Preview Bus you want to switch to. 
2- Press the Cut button. 

 
To Dissolve 

3- Select the video source on the Preview Bus you want to switch to. 
4- To manually dissolve, pull or push the T-Bar towards or away from you. 
5- To Automatically dissolve, press the Auto Trans button. 

 
To Bring in the Character Generator (CG) 

6- Press the DSK button. (Press the DSK button again to remove CG) 
 
To Fade to Black 
     7- Press the Fade to Black button (Press Fade to Black button to fade UP from black) 

1, 3 2 4 5 6 

7 
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WEEK 2      
 
Selecting Effects 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To Select an Effect: 

1- Press the Effect button, it will li
2- Press the Direct Pattern button, i
3- Press Number buttons (0-9) to g
4- Press Up or Down buttons to scr
Or, if you have found an effect yo
Operators Manual: 
5- Follow Steps 1-2 
6- Press the Set button, it will light
7- Type in number of effect. 
8- Press Enter. 
25

 
 

ght. 
t will light. 
et to effect sub group. 
oll through effects. 
u would like to use out of the Switcher 

. 

1 

2 

3,7 

4 

6 

8 
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Week 3  
Audio and Character Generator 
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WEEK 3      
 
Microphones 
 
Pick up Pattern- The zone within which a microphone can hear well. (Omni- and Uni- 
directional) 
 
Omnidirectional- hears equally well from all directions.  
 
Unidirectional- hears especially well in one direction. 
 
 Cardioid- Unidirectional mic which has a heart-shaped pickup pattern. 
  

Hypercardioid- Unidirectional mics which has a “long reach,” meaning it can 
pick up sounds that are farther away. Because these mics are fairly long and are 
aimed at the sound source, they are commonly called Shotgun mics.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Omnidirectonal Uni-directonal 
Cardioid 

Uni-directonal 
HyperCardioid 
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Microphones 
 
Lavaliere (Lav) Microphone- a very small, rugged, omnidirectional microphone that is 
used primarily for voice pickup. Usually clipped to clothing.  

 
 
Hand Held Microphones- a microphone that is handled by the talent, used in situations 
in which you need to exercise some control over the sound pickup.  

 
 
Shotgun (Boom) Microphone- a long, unidirectional microphone that is used to pick up 
sound sources farther from the microphone; used whenever the mic is to be kept out of 
the picture. 

 
 

Pressure Zone Microphone (PZM)- a small omnidirectional boundary microphone that 
can be placed on a table, wall, floor, lectern, or any flat surface. A small microphone is 
mounted face-down a short distance from the reflective boundary plate. This creates a 
pressure zone between the plate and the mic. The microphone detects changes in this 
pressure zone, rather than the conventional method of detecting changes in the 
surrounding air pressure (i.e. sound waves). 
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Connector 
 
 

Female 
XLR 

Male 
XLR 

Male 
RCA 

Female 
RCA 

Male 
Phone 

(Quarter Inch)  

Male 
Mini  
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Studio Panel 
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WEEK 3      
 
Audio Board 
 
 Power Switch 

Trim 

Auxiliary Inputs 

EQ-High 

EQ- Mids 

EQ- Low VU Meter 

Control Room 
Volume Control 

Phantom Power 
 31

Faders 1-8: 
Microphone Inputs 

Faders 9-16: 
Patchable Inputs 

Pan Left or Right 

Mute Button 
Mute Indicator Light 
 Solo Indicator Light 

Fader 

Sends to Sub-Mix  
Send to Main-Mix  

 Solo Button 

Studio 
Foldback 

Main Mix 
Master Fader 

Announce 
Booth 

Foldback 
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WEEK 3      
 
Setting Up the Audio Board 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1- Slide Main Mix Fader to 0db or Unity 
2- Slide faders 15 and 16 to 0db or Unity 
3- Pan 15 to the Left and Pan 16 to the Right 
4- Adjust Trim on 15 and 16 until the VU Levels are at 0db 
5- Adjust Control room volume to desired level 
6- Adjust Levels on VTR 1 to -20db 

You have now calibrated the output from the mixer with the input of the deck.  
 

1 

2 

3 

4 

5 

6 
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Week 3  
Character Generator 
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WEEK 3      
 
The Character Generator 
 
1. Open Deko500 Program 
 

 
 
 

 
2. Click: Window>Select Layout>Style Edit or ALT + F11 on the keyboard 
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WEEK 3      
 
The Character Generator 
 
3. To open a Graphic: File>Open 
 

 
 
 

 
4. Creating a New Graphic : Layer>Delete Layer 
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WEEK 3      
 
The Character Generator 
 
5. Click on Preset Style Window 
 

 
 
 

 
6. Click : Presets>Reset to Defaults 
 

 

5 
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WEEK 3      
 
The Character Generator 
 
7. Select I-Beam tool 
8. Draw text box from safe title area to safe title area 
 

 
 

 
9. Click on a font and type desired text 
 

7 

8 

9 
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WEEK 3      
 
The Character Generator 
 
10. Click one letter to the end of the row or page you wish to select, Right Arrow over, 
then Shift + Left Arrow till all text is selected. 
 

 
 

 
11. Manipulate Font Look and Style. 
 

 
 

10 
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WEEK 3      
 
The Character Generator 
 
12. To Create Text Roll: Text>Vertical Scrolling 
 

 
 
 

 
13. Select I-Beam and Drag Text Box from safe title to safe title, Click on a font and type 
desired text. 
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WEEK 3      
 
The Character Generator 
 
14. To Create a Sequence: Window>Select Layout>Sequence Playback or F11 on 
keyboard  
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WEEK 3      
 
The Character Generator 
 
 
Creating a Sequence 
15. Select Event 1 
16. Change Options to Control: Stop, Time: 0, Effect: Dissolve, Layers: Blank, File 
Name: Blank, Rate: 15, Units: Frames. 
17. Select Browse 
18. To import a file: Double Click (always start with a blank page) 
19. Remember to change credit roll Effect to Roll and Unit to Seconds.  
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 

 

15 

16 

18 

19 

17 
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WEEK 3      
 
The Character Generator 
 
Short Cuts to Remember 
 
Alt + Arrow: Move Object 
CTRL + Space Bar: Fine Movement vs. Course 
Alt + F11: Style Edit 
F11: Sequence Playback 
F5: New Graphic 
 

 
 
 
 
 

 
 
 

Add 
Text 

I-Beam 

Move 
Tool 

Rotate/Skew 
Tool 

Add 
Rectangle 

Add 
Ellipse 

Pointer 


